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About This Guide

This guide describes how to use the following safety dashboards: Benchmarks and the Risk
Forecast. Your access to view these dashboards are set by your administrator.

In This Section
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Overview

Construction Intelligence Cloud (CIC) is a smart Al-powered cloud application that identifies
potential safety issues associated with construction projects. CIC's construction-trained Al
delivers unbiased insights, predicts where to focus your attention, and prescribes specific
actions to mitigate safety risk.

Accessing Construction Intelligence Cloud

When your organization is provisioned with Construction Intelligence Cloud, you will receive the
Construction Intelligence Cloud Application URL in a Welcome email.

To sign in for the first time as a user of CIC:

1) In your Welcome email, click the application URL available in the format:
https://<host>:<port>/cicadmin
where
<host>:The host name or the server IP address of CIC application.
<port>: The unique port number associated with the CIC application.

Note: For a list of supported browser versions, see the Client System
Requirements document.

2) Inthe Username field, enter the user name assigned to you.

3) Inthe Password field, enter a unique alphanumeric password. After your initial sign in, you
can proceed to Reset Your Password English/admin/admin_guide/89031.htm.
4) Click Sign In.

5) Use the Navigator pane to explore the menu options available to you. For more details, see
Navigation Overview English/admin/admin_guide/89187.htm.
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About Your Login Credentials

New customers receive an initial email from no-reply@oracle.com to activate their Oracle Cloud
account. The link has an expiration date mentioned at the bottom of the email. Make sure to
activate your account before the link expires.

You will receive a separate welcome email from no-reply@primavera.oraclecloud.com that
includes the URL to access Construction Intelligence Cloud.

All other email communications coming from your Construction Intelligence Cloud environment
will be sent from no-reply@primavera.oraclecloud.com.

Tips
» If you do not receive either email, check the spam or junk folder in your email account, or

reach out to your customer success manager or CIC administrator.

» In case you miss the activation window to activate your Construction Intelligence Cloud
account, reach out to your customer success manager or CIC Administrator.

» Add no-reply@oracle.com and no-reply@primavera.oraclecloud.com to your address book
or list of approved contacts.

Reset Your Password

You can reset your password for CIC at any time.
To reset your password:

1) Navigate to the Oracle Cloud Account Sign In page.

2) Select the Need help Signing in? Click here link.

3) Onthe Forgot your password page, enter your username, and then click Next.
4) Review the on-screen message, and click Submit.

5) Select Password Reset in the email you receive.

6) On the Reset Your Password page, complete the New Password and Confirm New
Password fields.

Note: The Confirm New Password field will not be active until your new
password meets the specified criteria.

7) Click Submit.

8) Select Click here to continue to navigate back to the Oracle Cloud Account Sign In page,
and log in with your new password.

Note: To allow time for system processing, it is recommended that you
wait a few minutes before logging in with your new password.
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Navigation Overview

The Home page of the Construction Intelligence Cloud displays the following menu and options.

Menu / Option Description
Select to expand or collapse the Navigator pane.

= Navigation
Menu

®@ Help The Help menu displays the following options:
» Oracle Help Center: Select this option to access all guides in the
CIC library.

» Training: Select this option to access training resources available
for CIC.

» Support: Select this option if you need information on how to
contact Oracle Support (see "Support” on page 35).

» About: View the product version and build information of CIC.

1 Displays the initials of the signed-in user.
Select this option to sign out of the application.

2 Navigator

The Navigator displays the modules you can access based on your
role and the modules your organization has purchased.
» Overview: This is the main landing page.
» Safety: Select this option to view the safety dashboards.
» Administration: This option is available only if you are an
administrator for Construction Intelligence Cloud.
The following options display under Administration:
Data Management: Select this option to set up and manage data
sources.
User Management: Select this option to set up and manage
users.

3 The selected module page is displayed. You can select the tiles
displayed on the page to navigate within the selected module.
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Navigating within the Application
You can navigate within the application using either the Navigator or the tiles on the page.
Using the Navigator:

1) Click the = Navigation Menu to display the Navigator pane.
2) Inthe Navigator pane, select a module.
Examples:

» To access the Administration module: In the Navigator pane, select Administration.
» To access the Benchmarks dashboard in the Safety module: In the Navigator pane, select

Safety, and then select Benchmarks.
Using tiles
From the Overview page or from any of the module pages, select the tiles displayed on the
pane.
Examples:

» To select the Administration module: From the Overview page, select the Administration
tile.

» To access the Benchmarks dashboard in the Safety module: From the Overview page,
select the Safety tile, and then select the Benchmarks tile.

Product Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility
Program website (https://www.oracle.com/corporate/accessibility/).

Keyboard Shortcuts

General Interactive Keyboard Shortcuts

Action Keys
Move to the next tab stop Tab



https://www.oracle.com/corporate/accessibility/
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Move to the previous tab stop

Shift+Tab

Toggle between row selection and cell
selection

F8

Open the column header menu, when
focus is on the column header

Enter or Space

Increase column width, when focus is on
the column header

Windows: Ctrl+Right arrow
Mac: Ctrl+Cmd+Right arrow

Decrease column width, when focus is on
the column header

Windows: Ctrl+Left arrow
Mac: Ctrl+Cmd+Left arrow

Move column to next column position,
when focus is on the column header

Shift+Right arrow

Move column to the previous column
position, when focus is on the column
header

Shift+Left arrow

Sort ascending on the current column,
when focus is on the column header

Windows: Alt+Up arrow
Mac: Option+ Up arrow

Sort ascending on the current column in
addition to the existing search columns,
when focus is on the column header

Windows: Shift+Alt+Up arrow
Mac: Shift+Option+ Up arrow

Sort descending on the current column,
when focus is on the column header

Windows: Alt+Down arrow
Mac: Option+ Down arrow

Sort descending on the current column in
addition to the existing search columns,
when focus is on the column header

Mac: Shift+Option+Down arrow

Move to next tab stop in column header
menu, when column header menu is open

Tab

Move to previous tab stop in the column
header menu, when column header menu
is open

Shift+Tab

Close the column header menu, when the
column header menu is open

Escape

Show help (if defined) for an item, when a
single row is viewed and focus is on the
column

Windows: Alt+F1
Mac: Option+F1
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Date Picker

Action

Keys

Open the popup, when the input
has focus and Display Mode is set
to popup

Down arrow

Close the popup and focus the
input, when Display Mode is set to

popup

Escape

Focus the next element

Tab

Note: When the Display Mode is set to popup
and the last element is focused, pressing Tab
moves focus to the first element

Focus the previous element

Shift+Tab

Note: When the Display Mode is set to popup and
the first element is focused, pressing Tab moves
focus to the last element

Move focus to the same day of the |Up arrow
previous week

Move focus to the same day of the | Down arrow
next week

Move focus to the previous day Left arrow
Move focus to the next day Right arrow
Move focus to the first day of the |Home
current week

Move focus to the last day of the |End

current week

Change the grid of dates to the Page Up
previous month

Change the grid of dates to the Page Down

next month

Change the grid of dates to the
previous year

Shift+Page Up

Change the grid of dates to the
next year

Shift+Page Down

Select the focused date, when
Show Time is off

Enter or Space

10
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Select the focused date, when
Show Time is on

Enter or Space, then Done

11






About Safety Dashboards

Benchmarks Dashboard

Use the Benchmarks dashboard to view how your project or portfolio of projects are performing
against our proprietary benchmarks. The three tabs (Company Level Benchmarks, Project Level
Benchmarks, and Project Directory) within the dashboard allow you to view risks at either the
company level, project level, or to view performance across your portfolio of projects.

See topic Benchmarks Dashboards (on page 13) for a detailed description of each dashboard
and the metrics behind the dashboard.

Risk Forecast Dashboard

Use the Risk Forecast dashboard to view projects that are at risk for having a safety incident.
Five tabs: (Weekly Risk Summary, Weekly Project Risk, Risk Report Card, Risk Level vs
Incident History, and Model Performance) within the dashboard allow you to track weekly risk
predictions at the company level and project level. You can use this dashboard to view project
risks along with the corresponding recommended actions, view the detailed data behind the
predictions, compare risk mitigation efforts for each week, and monitor the risk trends for the life
of your project.

See topic Risk Forecast Dashboards (on page 22) for a detailed description of each
dashboard.

In This Section

Benchmarks DaShBDOAITS ........oveiiii ettt r e e eeenas 13
RISk FOrecast DashbOards ...........vviuiiiiii e e e e e e e 22
S]] o) 0 L0 S 35

Benchmarks Dashboards

The Benchmarks dashboard provides important metrics to help you gain insights into the safety
performance of projects your company manages. As a user with access to single or multiple
projects, you can use the dashboard to view how projects are performing against company
safety benchmarks. In addition to providing key metrics data, the dashboard also provides
actions you can take to help the project optimize safety performance.

The dashboard has three tabs: Company-Level Benchmarks, Project Directory, and
Project-Level Benchmarks. Use Company Level Benchmarks to view metrics for all projects or a
subset of projects. The Project-Level Benchmarks allows you to view metrics for a single project,
and the Project Directory tab allows you to view metrics across multiple projects.

13
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About Benchmark Metrics

The following metrics are displayed in the Benchmarks dashboard:
Work Observation Rate (WOR)

It is the number of worker hours divided by the number of observations made over the same
duration WOR is a measure of workforce engagement by the safety program in place on
the project. For example, a project having five workers working 40 hours a week (200 total
hours) and engaged in a safety conversation in their work area at least once in that week
would result in a WOR of 200 hrs./obs. The target value for the WOR metric is 100 hrs/obs.

Staff Observation Rate (SOR)

It is the number of worker hours divided by the number of observations made over the same
duration. SOR is a measure of how engaged project supervision is in the engagement of a
project. For example, a project having four staff employees who all work 40 hours each (160
hours total) perform a total of four observations that same week would result in an SOR of 40
hrs./obs. The target value of the SOR metric is 40 hrs./obs.

Incident Frequency Rate (IFR)

It is the number of incidents times 100,000 divided by the total number of hours worked over
the same duration. IFR is a measure of how frequently incidents of all severity levels are
reported on a project. This metric is indicative of a healthy reporting culture and shows that
the organization has established a safe environment for reporting all incidents, including
minor incidents. The target value of IFR is between 12.0 to 25.0. This equates to a project
identifying and reporting an incident for every 4,000 to 8,000 hours worked on a job site.

Average Incident Severity (AlS)

It is the average severity of all incidents that take place over a fixed duration. AIS measures
whether the incident being reported is of the right type. To calculate the AlS, incidents are
given a severity score based on their type as indicated below:

Severity (OSHA-USA) Severity (HSE- UK) Severity (AUS-WHS) |Score
Near Miss Near Miss Near Miss 1
Property Damage Property Damage  |Property Damage |2
First Aid Injury First Aid Injury First Aid Injury 3
Recordable Injury Dangerous Dangerous 4
Occurrence/Over Incident/Serious

3-Day Incapacitation | Injury or llliness

Restricted Duty/Transfer Over 7-Day Cases or Alternate |5
Incapacitation Work

Lost Time Specified Injuries Lost Time 6

Fatality Fatality Fatality 7

14
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Company Level Benchmarks

Access Company Level Benchmarks

1) From the = Navigation Menu, click Safety, and then select Benchmarks.
The default page Company Level Benchmarks is displayed.

2) Click the Company Level Benchmarks tab.
Note: Your access to dashboards is set by your administrator.

Purpose

Use the Company Level Benchmarks dashboard to view metrics across all or a subset of
projects. It displays key data to help you evaluate the selected projects against pre-defined
benchmarks. You can use this dashboard to:

» View the safety performance of all your projects at the company-level and compare them
against the pre-defined benchmarks.

» View the following safety metrics for your project: WOR, SOR, IFR, and AIS. For more
information, see topic About Benchmark Metrics.

View recommended actions to take based on the project performance.
View the data driving the metric results both in aggregate and over time.

The following screen elements are displayed on the Company Level Benchmarks dashboard:

15
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Screen Elements

Description

1

Displays the time the data was imported.

2

View Data button. Select to view the data used to
generate the dashboard. The following metrics is
displayed in the dialog box:

» Incidents: All, Recordables, Average Incident
Severity, Average Hours per Incident

» Observations: Total, Average Users, Risk
Observation, Combined Observation Rate

» Trade Labor: Manpower Entries, Average Number of
Trades, Average Number of Workers, Hours

» Payroll/Time cards: Payroll Entries, Hours, Staff
Hours, Craft Hours

Filter icon. Select to filter on date range. The options
include: Latest Import, All Time, Last Week, Month to
Date, Quarter to Date, and Year to Date.

Metrics Tiles. Each tile displays the following
information:

» Name of the metrics

» Severity badge (Critical, Warning): displays only if the
metrics is above the benchmark value.
Metrics value
Percentage above or below the benchmark
Benchmark value

For more information, see topic About Benchmark
Metrics.

Displays recommend actions if your project metrics is
either above or below the benchmark threshold.

Displays an interactive graph to view metrics over the
time period and compare it against pre-defined
benchmark values.

Tabs to navigate to the Company Level Benchmark,
Project Details and Project Level Benchmarks pages.

How to use the dashboard

» Review the high-level metrics displayed on the Metrics Tiles.

16
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» View the metrics graph by selecting a metric from the Metrics Tiles. For example, when you
click the Work Observation Rate WOR tile, the graph for the WOR metric is displayed. It
shows the time period (week ending), WOR values, benchmark values, and the observation
count.

View the data for a specific time period by hovering over the graphic.
View the recommended actions under the Metrics Tiles.
View the data used to generate the graph by clicking the View Data button.

Project Directory

Access Project Directory

1) Fromthe = Navigation Menu, click Safety, and then select Benchmarks.
The default page Company Level Benchmarks is displayed.

2) Select the Project Directory tab.
Note: Your access to dashboards is set by your administrator.

Purpose

Use the Project Directory dashboard to view safety metrics for a selected list of projects. It
displays key data to help you view how projects are performing against pre-defined safety
benchmarks. You can use this dashboard to:

See how selected projects are comparing against pre-defined safety benchmarks.

Identify project safety metrics that are either below or above thresholds. The metrics are
color coded for easy identification.

Filter the projects list to expand or narrow your search criteria.

View the following safety metrics for all selected projects: WOR, SOR, IFR, and AlS. For
more information, see topic About Benchmark Metrics.

17



Advisor for Safety User Guide

» View the data driving the metric results.

The following screen elements are displayed on the Project Directory dashboard:

Screen Elements Description
1 Displays the time the data was imported.
2 More Actions drop-down menu:

» Select Projects: Opens the Select Projects for
Comparison dialog box. You can select the projects
you want to view metrics and compare.

» View Data: Select to view the data used to generate
the dashboard. The following metrics is displayed in
the dialog box:

» Incidents: All, Recordables, Average Incident
Severity, Average Hours per Incident

» Observations: Total, Average Users, Risk
Observation, Combined Observation Rate

» Trade Labor: Manpower Entries, Average
Number of Trades, Average Number of Workers,
Hours

» Payroll/Time cards: Payroll Entries, Hours, Staff
Hours, Craft Hours

18
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3 Filter icon. Select to filter on date range. The options
include: Latest Import, All Time, Last Week, Month to
Date, Quarter to Date, and Year to Date.

4 Metrics Tiles - Each tile displays the following

information:

» Name of the metrics

» Severity badge (Critical, Warning): displays only if the
metrics is above the benchmark value.

» Metrics value

» Percentage above or below the benchmark

» Benchmark value

For a description of the metrics, see topic About
Benchmark Metrics.

5 Metrics Table - Provides detailed statistics for the
observations and incidents recorded at the project level.
The following information is displayed:
» Project
» Observations

» Total

»  Worker hours

» WOR (WOR at project level)

»  Staff hours

» SOR (SOR at project level)

» Target Observations
» Incidents

» Total Incidents (Count of all incidents on that
project)

» AIS (AIS at project level)
» IFR (at project level)
» Target Incidents

6 Tabs to navigate to the Company Level Benchmark,
Project Details and Project Level Benchmarks pages.

How to use the dashboard

» Choose the projects to compare:
a. From the More Actions drop-down list, choose Select Projects.

b. From the Select Projects for Comparison dialog box, select your projects and click
Apply.

19
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View the high-level metrics for all projects displayed on the Metrics Tiles.
Compare the metrics for each project. The metrics are color coded for easy identification.

View the data used to generate the table. From the More Actions drop-down list, choose
View Data.

Project Level Benchmarks
Access Project Level Benchmarks

1) From the = Navigation Menu, click Safety, and then select Benchmarks.
The default page Company Level Benchmarks is displayed.

2) Select the Project Level Benchmark tab.
Note: Your access to dashboards is set by your administrator.

Purpose

Use the Project Level Benchmarks dashboard to view safety metrics for a specific project. It
displays key data to help you view how your project is performing against pre-defined safety
benchmarks. You can use this dashboard to:

» See how your project is comparing against pre-defined safety benchmarks.

» View the following metrics for your project: WOR, SOR, IFR, and AlS. For more information,
see topic About Benchmark Metrics.

» View recommended actions based on project performance.

20
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» View the data driving the metric results both in aggregate and over time.

The following screen elements are displayed on the Project Level Benchmarks dashboard:

Screen Elements Description

1 Project drop-down list. Displays all the project you can
access. The projects are sorted in alphabetically order.
Use the drop-down to select your project.

2 Displays the time the data was imported.

3 View Data button. Select to view the data used to

generate the dashboard. The following metrics is

displayed in the dialog box:

» Incidents: All, Recordables, Average Incident
Severity, Average Hours per Incident

» Observations: Total, Average Users, Risk
Observation, Combined Observation Rate

» Trade Labor: Manpower Entries, Average Number of
Trades, Average Number of Workers, Hours

» Payroll/Time cards: Payroll Entries, Hours, Staff
Hours, Craft Hours

4 Filter icon. Select to filter on date range. The options
include: Latest Import, All Time, Last Week, Month to
Date, Quarter to Date, and Year to Date.

21
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5 Metrics Tiles. Each tile displays the following
information:

» Name of the metrics

» Severity badge (Critical, Warning): displays only if the
metrics is above the benchmark value.
Metrics value
Percentage above or below the benchmark
Benchmark value

For a description of the metrics, see topic About
Benchmark Metrics.

6 Displays recommend actions if your project metrics is
either above or below the benchmark threshold.

7 Displays an interactive graph to view metrics over the
time period and compare it against pre-defined
benchmark values.

8 Tabs to navigate to the Company Level Benchmark,
Project Details and Project Level Benchmarks pages.

How to use the dashboard

From the Project drop-down list, select a project.

View the high-level metrics displayed on the Metrics Tiles.

From the Metrics Tiles, select a metric to view the graph for the selected metric. For
example, when you select the Work Observation Rate WOR tile, the graph for the WOR
metric is displayed. It shows the week ending, WOR values, benchmark values, and the
observation count.

Hover over the graphic to view the data for a specific time period.

View the recommended actions under the Metrics Tiles.

View the data used to generate the graph. Click the View Data button.

Risk Forecast Dashboards

Use the Risk Forecast dashboards to assess which of your projects are at risk of having a
safety incident in the coming weeks. It also shows the factors that are driving the risk and the
actions project teams can take to mitigate the risk. Multiple dashboards allow you to view either
a high-level list of all projects that are ranked based on their risk score, or view risks levels for
individual projects. Use these dashboards to:

» Monitor your projects closely and track the risk rankings on a weekly basis to see if adequate
actions are being taken on the project.

22
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Review project priorities and recommended actions to help mitigate safety risks.

Track model performance over time with a detailed list of safety incidents and the rank of the
project on which they occurred.

Compare the risk level with the incident history for your project.
View all risk factors applicable to your projects along with their definitions.

The following dashboards are part of the Risk Forecast dashboard: Weekly Risk Summary,
Weekly Project Risk, Risk Report Card, Risk Level vs Incident History, and Model Performance.

Weekly Safety Risk Summary
Access Weekly Safety Risk Summary

1) From the = Navigation Menu, click Safety and then select Risk Forecast.
The default page Weekly Safety Risk Summary is displayed.

2) Select the Weekly Safety Risk Summary tab.

Note: Your access to dashboard tabs is set by your administrator. The
tab visibility is based on user roles- a multi-project user has access to all
tabs, while a single project user can only access the Weekly Project
Risk, Risk Report Card, and the Risk Level vs Incident History tabs.

Purpose

Use the Weekly Safety Risk Summary dashboard to view a high-level list of all projects
analyzed by your model that are at risk for having safety incidents. You can use this dashboard
to:

» View the overall risk ranking for the projects in your portfolio. The risk rank is based on the
likelihood of an incident occuring in the coming week.

» Understand the risk factors driving the incident risk on each project.

23
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» Take action to reduce risk by implementing the recommended actions.

The following screen elements are displayed on the Weekly Safety Risk Summary dashboard:

Screen Elements Description

1 Displays the date the data was last imported. The
dashboard predictions are based on the data for the
week prior to this date.

2 Project Risk Rank Ending - Displays the week ending
date. The project ranking is calculated for the week
ending on the date specified.

3 View Data button. Select to view the data used to
generate the dashboard. The following metrics is
displayed in the dialog box:

» Incidents: Total Last Week, Recordables Last Week,
JTD Incidents, JTD Recordables

» Observations: Total Last Week, Worker Observation
Rate, Staff Observation Rate, Average Observation
Risk

» Trade Labor: Total Worker Days, Total Hours,
Percent Apprentices, Supervision Ratio

» Payroll/Head Count: Total Head Count, Total Hours,
Safety Hours, Safety Ratio

» Photos: Photo Count, Photo Coverage, Work at
Height Composite

4 Filter button. Select to filter the projects list.

24
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5 Rank column. Display a numerical risk rank for each
project. The risks are color coded as follows:

» Red: High risk

» Brown: Elevated risk

» Gray: Lower risk

6 Project column. Displays the ID and the name of the
project.
7 Change column. Displays the change in project risk rank

from last week's predictions. The numeric value shows
the change in ranking, and the arrow indicates whether
the project has moved up or down the list. An up arrow in
red color indicates that the project's risk rank has
increased, while a down arrow in green indicates that a
project has decreased its project risks.

A value of 0 indicates that there is no change in risk rank
from last week.

8 Priorities and Actions pane. Displays the project
priorities and the recommended actions. The priorities
are labeled as High, Medium, Low, and No action. The
metric is listed along with the recommended actions. You
can hover over the Tool Tip icon to view a definition of
the metric.

Weekly Risk Summary, Tabs to navigate to the Weekly Risk Summary, Weekly
Weekly Project Risk, Risk | Project Risk, Risk Report Card, Risk Level vs Incident
Report Card, Risk Level vs | History, and Model Performance pages.

Incident History, and Model
Performance tabs.

How to use the dashboard
1) View projects that are at high risk for safety incidents by monitoring the Rank and Change
column for each project.

2) Use the Change column number and arrows to see how much the risk rank of a project has
changed from the prior week.

3) Select an individual project from the Project column to view the priorities and actions that
must be taken on the selected project. The priorities and actions are displayed on the right
pane.

4) Hover over the Tool Tip icon to view a description of the metrics.

5) Click the View Data button to view the metrics detail that was used to predict risks. This data
is an aggregation of the metrics across all projects.
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Weekly Project Risk

Access Weekly Project Risk Summary

1) From the = Navigation Menu, click Safety and then select Risk Forecast.
The default page Weekly Safety Risk Summary is displayed.

2) Select the Weekly Project Risk tab.

Note: Your access to dashboard tabs is set by your administrator. The
tab visibility is based on user roles- a multi-project user has access to all
tabs, while a single project user can only access the Weekly Project
Risk, Risk Report Card, and the Risk Level vs Incident History tabs.

Purpose

Use the Weekly Project Risk Summary dashboard to view the risk predictions for a single
project. You can use this dashboard to:

View risk predictions for one project at a time.

View the risk ranking.

Review your project priorities and the actions you can take to mitigate potential safety risks.
View project details, and the weather forecast for the week.

View the data that was used to display the risk predictions.

v v v v Vv

The following screen elements are displayed on the Weekly Project Risk:
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Screen Elements Description

1 Project drop-down list. Select the drop-down list to select
a project.
Note: Some users may only have access to a single
project.

2 Project information and weekly rank. The following

project information is displayed:

Start date of the project.

Finish date of the project.
Duration of the project in weeks.
Project percent complete by time.
The project's group.

Project type.

Estimated value of the project.

v v vV v v v Vv

3 View Data button. Select to view the data used to
generate the dashboard. The following metrics is
displayed in the dialog box:

» Incidents: Total Last Week, Recordables Last Week,
JTD Incidents, JTD Recordables

» Observations: Total Last Week, Worker Observation
Rate, Staff Observation Rate, Average Observation
Risk

» Trade Labor: Total Worker Days, Total Hours,
Percent Apprentices, Supervision Ratio

» Payroll/Head Count: Total Head Count, Total Hours,
Safety Hours, Safety Ratio

» Photos: Photo Count, Photo Coverage, Work at
Height Composite

4 Filter button. Select to filter the projects list.

5 Displays the priority of the actions to take.

6 Feature priority and actions for the week ending.

7 Tool Tip icon. You can hover over the Tool Tip icon to

view a definition of the metric.

8 Displays the weather forecast of the current week
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Weekly Risk Summary, Tabs to navigate to the Weekly Risk Summary, Weekly
Weekly Project Risk, Risk Project Risk, Risk Report Card, Risk Level vs Incident
Report Card, Risk Level vs |History, and Model Performance pages.

Incident History, and Model
Performance tabs.

How to use the dashboard

From the Project drop-down list, select a project.

Review the project details and the weekly rank.

View the priorities and actions that must be taken on the selected project.
Hover over the Tool Tip icon to view a description of the metrics.

View the metrics detail that was used to generate the risk predictions. Click the View Data
button.

v v v v Vv

Risks Report Card

Access Risks Report Card

1) Fromthe = Navigation Menu, click Safety and then select Risk Forecast.
The default page Weekly Safety Risk Summary is displayed.

2) Select the Risks Report Card tab.

Note: Your access to dashboard tabs is set by your administrator. The
tab visibility is based on user roles- a multi-project user has access to all
tabs, while a single project user can only access the Weekly Project
Risk, Risk Report Card, and the Risk Level vs Incident History tabs.

Purpose

Use the Risk Report Card dashboard to view if the safety risk metrics on projects have changed
compared to the previous week. You can use this dashboard to:

» Review the risk mitigation actions for the selected week and prior weeks.
» Compare how well a project performed at following and implementing the recommendations.
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» View a project's risk ranking for a selected week and compare it with the prior week's
ranking.

The following screen elements are displayed on the Risks Report Card dashboard:

Screen Elements Description

1 Project drop-down list. Select the drop-down list to select
a project.

2 Displays the day the data was last imported. The risk

rank is from the predictions made prior to the week
ending date specified.

3 Filter button. Select to filter the projects list.

4 Week Ending drop-down list. Select the week ending you
want to review.

5 Selected Week's Rank. Displays the rank of the selected
project, the change in rank from the previous week, a red
or green arrow indicating if the risks have increased or
decreased, and the date of the selected week ending.

6 Prior Week's Rank. Displays the rank of the selected
project for the week prior to the selected week ending,
and the week ending date.
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7 Actions of the Week. Displays the priority (High, Medium,
or Low), the risk trend (Up or Down arrow), and the
recommended actions to mitigate the risks.

Weekly Risk Summary, Tabs to navigate to the Weekly Risk Summary, Weekly
Weekly Project Risk, Risk | Project Risk, Risk Report Card, Risk Level vs Incident
Report Card, Risk Level vs | History, and Model Performance pages.

Incident History, and Model
Performance tabs.

How to use the dashboard

From the Project drop-down list, select your project.
From the Week Ending drop-down list, select a week ending date.

Review the risk rank for the selected week and the prior week. Note if there was an
improvement in the ranking.

Monitor if the project risk drivers are trending in the right direction.
Review the priorities and actions that were recommended for the selected week ending.

Risk Level vs Incident History

Access Risk Level vs Incident History

1) From the = Navigation Menu, click Safety and then select Risk Forecast.
The default page Weekly Safety Risk Summary is displayed.

2) Select the Risk Level vs Incident History tab.

Note: Your access to dashboard tabs is set by your administrator. The
tab visibility is based on user roles- a multi-project user has access to all
tabs, while a single project user can only access the Weekly Project
Risk, Risk Report Card, and the Risk Level vs Incident History tabs.

Purpose

Use the Risk Level vs Incident History dashboard to view if the safety risks associated with
your project were reduced compared to the previous weeks. You can use this dashboard to:

» Track the risk level of a project over the duration of the project.
» Track the incidents reported on the selected project.
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» Track if a project has made progress in reducing safety risks.

The following screen elements are displayed on the Risk Level vs Incident History dashboard:

Screen Elements Description

1 Project drop-down list. Displays the name of the project.
Select the drop-down list to select a project. Only the
projects you have access to are displayed.

2 Displays the day the data was last imported.
3 Filter button. Select to filter the projects list.
4 Incidents line chart. If an incident (minor or recordable)

was reported for a week, a line chart is plotted to display
the incident. A red line is displayed for recordables, and a
yellow line is used to denote minor incidents. If a week
has both minor and recordables, the line is displayed only
in red. Click on an incident line on the graph to filter the
table and the incident chart to only display incidents that
are applicable to the selected week ending.
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5 Project Risk Level and Incident Timeline graph.
Interactive graph displays the risks levels along with the
week endings. Risk level is a value between 1 and 100
expressed in percent. It reflects the percentage of
projects that are ranked lower than the selected project.
The higher the value of risk level, the higher the risk of
the project have an incident.

6 Incidents Report table. Display all the incidents for the
project in increasing order of date. When the incident line
is selected from Incident Line chart, the data is filtered to
show the incidents for the selected week ending.

The following details are displayed (if available):

Date of incident

ID of the incident

Type of the incident

Injury

OSHA status

Severity. A value ranging from 1 to 7, where 1lis a
near miss and 7 is a fatality and 4 is a recordable. A
caution symbol is displayed for incidents of Severity 4
or more.

» Reported late

v v v v v Vv

7 Incident chart: Displays a count of minor and recordable
incidents. Click on the chart to filter the table to show
incidents of the selected type (Minor or Recordables).

Weekly Risk Summary, Tabs to navigate to the Weekly Risk Summary, Weekly
Weekly Project Risk, Risk Project Risk, Risk Report Card, Risk Level vs Incident
Report Card, Risk Level vs History, and Model Performance pages.

Incident History, and Model
Performance tabs.

How to use the dashboard

» From the Project drop-down list, select a project.

» Review the Project Risk Level and Incident Timeline graph to see how many risks and
incidents were reported on your project.

» Select the Incident line chart or the Incident chart to review the types of incidents that were
reported.

Model Performance

Access Weekly Project Risk Summary
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1) Fromthe = Navigation Menu, click Safety and then select Risk Forecast.
The default page Weekly Safety Risk Summary is displayed.

2) Select the Model Performance tab.

Note: Your access to dashboard tabs is set by your administrator. The
tab visibility is based on user roles- a multi-project user has access to all
tabs, while a single project user can only access the Weekly Project
Risk, Risk Report Card, and the Risk Level vs Incident History tabs.

Purpose

Use the Model Performance dashboard to assess if the risk models are accurately predicting
incidents across projects. You can use this dashboard to:

» Compare the risk predictions with the actual outcomes.

» View the types of incidents that were reported for a selected project and the rank of that
project assigned by the model.

» Review if the recommended actions are helping to mitigate the risks.

The following screen elements are displayed on the Model Performance:

Screen Elements Description

1 Displays the day the data was last imported.

2 Filter button. Select to filter the projects list.

3 Week Ending drop-down. Select the week ending date
you want to review.

4 The predicted rank for the project.

5 The name of the project. Click on the project name to

open the Incidents panel.
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6 Number of minor and recordable incidents reported for
the project in the selected week ending.

7 Incident chart. Display the total number of minor and
recordable incidents for all projects in a donut chart.
The total number of incidents is displayed in the center.

Incidents panel Incidents panel. Select a project to display the
Incidents panel. It displays all incidents reported for the
project.

The following details are displayed:

Date of incident

ID of the incident
Type of the incident
Injury

OSHA status

Severity. A value ranging from 1 to 7, where 1 is a
near miss, 7 is a fatality, and 4 is a recordable
incident. A caution symbol is displayed for incidents
of Severity 4 or more.

» Reported late

v v v v v Vv

Reason Definitions button |Reason Definitions button. A dialog box displays the
actionable and foundational reasons or features that the
model uses to make predictions.

Actionable reasons - Lists the features selected by the
model as significant which can be acted on by the project
team. The corrective course of action is also displayed.

Foundation reasons - Lists the features selected by the
model as significant but does not have any corrective
course of action as these reasons cannot be acted on by
the project team.

Weekly Risk Summary, Tabs to navigate to the Weekly Risk Summary, Weekly
Weekly Project Risk, Risk Project Risk, Risk Report Card, Risk Level vs Incident
Report Card, Risk Level vs | History, and Model Performance pages are displayed at
Incident History, and Model |the bottom of the page.

Performance tabs.

How to use the dashboard

» From the Week Ending drop-down list, select a week.

» Review the projected risk rank for all projects that have at least one minor or recordable
incident. If all or most of your projects are in green, then the model is performing well. If most
or all the project ranks are yellow, orange or red, it indicates that model did perform well for
the selected week and may need to be retrained.
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» Review the donut chart representing the total number of incidents (minor and recordable).
» Select a project to view the incident pane. Review the details of each incident from the pane.
» Select the chart to filter the incident table.

If you have a question about using Construction Intelligence Cloud that you cannot resolve with
information on Oracle Help Center, visit My Oracle Support (MOS).

Note: If you have an account at Construction and Engineering
Support Portal https://cegbu.custhelp.com/, you can log in to the
portal to create a service request. For more information see section
Oracle Support Portal (on page 41).

My Oracle Support

Visit our support website for the latest information on contacting Oracle Global Customer
Support and accessing our knowledge articles: https://support.oracle.com/
(https://[support.oracle.com/).

Once registered, you can search the Knowledge Base and communities, and learn our tips and
best practices for using MOS. Note that you must be granted access by your organization's CUA
to create SRs.

Oracle customers who have purchased support have access to electronic support through MOS.
For information, visit:

» My Oracle Support

» Oracle Accessibility Learning and Support
https://lwww.oracle.com/corporate/accessibility/learning-support/ (if you are hearing
impaired)

How to Register
Note: The steps below may be different if using the Cloud Portal.

1) Go to My Oracle Support and select Register as new user.
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2) Fill out the form and select Create Account. Oracle will send you an email to verify your
email address.
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3) Once your email address is verified, go back to My Oracle Support. Select Login to My
Oracle Support. Use the account credentials you just created to log in.
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4) Once logged in, locate the dropdown featuring your name along the upper-right and
select My Account.

5) Inthe Support Identifiers section, select Request Access.

6) Enter your Support Identifier (Sl), along with the first five letters of your organization name
if prompted. Your Sl is included in the Oracle welcome email; ask your Customer User
Administrator (CUA) to provide the information if needed.
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7) Select Request Access. The request will then be sent to the CUA for approval.

Note: You will be assigned as the CUA if you are the first person from
your organization to request access using your organization's Sl. See
Customer User Admin (CUA) (on page 39) for more details.

Once registered, you can search the Knowledge Base and communities, and learn our tips and
best practices for using MOS. Note that you must be granted access by your organization's CUA
to create SRs.

Oracle customers who have purchased support have access to electronic support through MOS.
For information, visit:

» My Oracle Support

» Oracle Accessibility Learning and Support
https://lwww.oracle.com/corporate/accessibility/learning-support/ (if you are hearing
impaired)

Customer User Admin (CUA)

The Customer User Admin (CUA) manages all users for their SI. The CUA can approve or deny
user access, assign user privileges, and more.

Oracle recommends having at least two CUAs for every Sl. The CUA can assign the role to
other users by following the steps below.

To assign a user as a CUA:
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Note: The steps below may be different if using the Cloud Portal.

1) Log into My Oracle Support. Select the drop-down menu next to your display name, and
then choose My Account.

2) Select Manage Users under the Administrative category on the left.
3) Select the row of the user you want to modify.

4) Their user details will display below. Select the row.

5) Inthe Role list, select Administrator.

6) Select Save.

For more information on the CUA role, select the Customer User Administrator tab on our
How-to Video Training Series page.

Create a Service Request (SR)

To access tutorials on how to create an SR, select the Service Request Management tab on
our How-to Video Training Series page. Note that you must be granted access by your
organization's CUA to create SRs.

When you create an SR, be sure to enter the correct product information and problem details so
that the request is assigned to the proper Oracle Support team.
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Information Centers

Information centers organize documents found on My Oracle Support (MOS) and provide access
to:

» Important support and product information, such as links to recently created knowledge base
articles and product announcements

» Oracle University training

» Communities where industry peers share best practices

Access the information center for your product here.

Support Renewals Process

If it's time to renew support for your Oracle products, or if you would like to sign up for
auto-renewal of your support services, visit My Support Renewals.

Additional MOS Help

» Learn our tips and best practices for using our support services.
» Watch the How-to Video Training Series
» Read our Working Effectively With Oracle Support - Best Practices guide
» Visit the My Oracle Support Communities to collaborate with peers and share best practices.

Oracle Support Portal

If you have a question about using Construction Intelligence Cloud that you cannot resolve with
information on Oracle Help Center, visit the Oracle Construction and Engineering Support
Portal (https://cegbu.custhelp.com/).

First time users can create an account at the Oracle Construction and Engineering Support
Portal (https://cegbu.custhelp.com/) by selecting Sign In/Sign Up or by going directly to
https://cegbu.custhelp.com/app/createContact
(https://lcegbu.custhelp.com/app/createContact). After signing up, log in to start using the
portal.

To learn more about getting support, review the Related Topics below or watch our video on
Using the Oracle Support Portal (https://www.oracle.com/ce-help/support-portal/).
Access to Oracle Support

Oracle customers have access to electronic support through Support Cloud. Contact Oracle
Global Customer Support using the Oracle Construction and Engineering Support Portal
(https://cegbu.custhelp.com/), or give us a call using the support phone number for your
region.

For information about Oracle's commitment to accessibility, visit Oracle Accessibility Program
(https://Iwww.oracle.com/corporate/accessibility/learning-support/).
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How to Ask a Question

The Oracle Construction and Engineering Support Portal allows you to easily ask our Support
Team questions.

To ask a question and create an Oracle Service Request (SR):

1) Select Ask A Question (https://cegbu.custhelp.com/app/ask) in the Oracle Construction
and Engineering Support Portal (https://cegbu.custhelp.com/).

2) On the Contact Form, enter the following details for your Oracle service request:
» Product: Select Construction Intelligence Cloud.
» Service Type: Select the option that best describes your request.

» Subject and Description: Enter details for your request. The more information you
provide, the quicker we can respond to your inquiry.

» Contact Information: Enter details for all required fields and include the email addresses
of any additional contacts.

3) Select Submit Request.
What happens next?

You will receive an email confirming that we have received your request. This email will include
your SR reference number, which can be used for your reference. You can reply to this emalil if
you would like to provide an update on your question.

A member of our Support team will review your question and respond as soon as possible. If you
would like to speak to our Support team, please call us and quote your SR reference number.
See the Support page for phone numbers.

If you would like to keep track of or update your question on the Support Portal, you may log in
or register as a new user. See How to Log In or Register on the Support Portal (on page 42).

How to Log In or Register on the Support Portal

Registering an account and logging in to the Oracle Construction & Engineering Support Portal
allows you keep track of and update the Oracle Service Requests (SRs) you have raised with
our Support team. This is optional, as you can still ask a question using the Ask A Question form
and communicate with our Support team by email.

To log in as an existing user:

1) Goto Sign In (https://cegbu.custhelp.com/app/utils/login).

2) Enter your Oracle account Username. This is typically your email address.

3) Enter your Password. If you have forgotten your password, select the information icon next
to the password field and enter your email address to receive a password reset link.

To register as a new user:

1) Goto Sign Up (https://cegbu.custhelp.com/app/createContact).
2) Enter your First Name, Last Name, and Email.

3) Select Create an Account.

4) Check your email for instructions on how to complete registration.
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Note: If you get a message stating that an account already exists with
your email address, this could be because:

You may have an existing Oracle account. If so, please proceed to Sign In
(https://lcegbu.custhelp.com/app/utils/login).

You may have been pre-configured on the Support Portal at the time of registering your Oracle
Cloud Service and would have received a ‘Welcome Email' with instructions on how to complete
setup. If you missed this, please proceed to create an Oracle account
(https://lcegbu.custhelp.com/app/createContact). Once your Oracle account is created, you
will be ready to log in to the Support Portal.

After you are logged in, you can:

» Review and update the Oracle service requests you have previously logged

» If you are an Admin user, you can also review and update the Oracle service requests your
organization has logged.

How to Review and Update Oracle Service Requests (SRs)

Upon logging in to the Oracle Construction & Engineering Support Portal, you will be able to
review, and update Oracle service requests (SRs) raised with our Support team. This is optional,
as you can still raise questions using the Ask A Question
(https://cegbu.custhelp.com/app/ask) form and communicate with our Support team by email.

To view your Oracle SRs:

1) Signin (https://cegbu.custhelp.com/app/utils/login) to Support Portal.

2) Once you have signed in, you will see your dashboard. You can select one of the tile
options, depending on what you would like to see:

» My Open SRs: Shows questions that you have logged that are currently open with our
Support Team.

» SRs Pending My Action: Shows questions that you have logged that require your
response.

» My Past SRs: Shows questions that you have previously logged, which have been
solved.

If you are an Admin user, you will also see:

» My Org Open SRs: Shows questions logged by users in your organization that are
currently open with our Support Team.

» My Past Org SRs: Shows questions that your organization has previously logged which
have been solved.

3) Inthe selected view you will find the Report Filters panel on the left, which you can use to
search your SRs by Reference #, Severity, Status, Sub-Status, and by Organization.

4) Selecting the blue hyperlinked SR Reference # will open the Communication History
page, from where you can view all communication with our Support Team, as well as
additional info such as the current status of the question.

To Update your questions:
1) Navigate to My Open SRs. (see instructions above on how to view your questions).
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2) Select the blue hyperlinked SR Reference # to open up the request you'd like to update.

3) Answer the question ‘Do you want a response?' with:
» Yes, please respond to my question: If you are adding additional information to the
question and would like a response from our Support Team

» No, I don't need this question answered now: If you are requesting the question to be
closed and do not require additional support

4) Add additional information to your question and attach any additional files as required.
5) Select Submit.

Note: You can also update an open question by simply replying to
emails our Support Team send you. When doing so, please ensure the
email subject is not changed so that it correctly routes to our team.

User Access Levels and Adding New Users

There are two types of access levels on the Oracle Construction & Engineering Support Portal,
Basic and Admin.

Basic User
Can create, view, and update their own questions.
Admin User

» Can create, view, and update their own questions.
» Can view and update all questions logged by users within their organization.
» Can add users from their organization to the Support Portal.

To add a new user from within your organization:

1) After you have signed in, select your email address at the top right corner of your dashboard
and select User Provisioning.

2) Fill out the first name, last name, and email fields in the form.

3) At this point, you can decide whether to add someone as a basic or admin user.
» If you want to add someone as a basic user, select Submit.

» To create an admin user, select the applicable organization from the Assign
Organization(s)/Instance(s) dropdown.
Your organization might be listed across more than one instance, so you can select each
occurrence in the dropdown list if you like, depending on what access you want the new
user to have.

» Each organization is listed with the product name, organization name, and the
Instance/server it is registered on.

4) After you have made your selection, select Submit.
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Note: If you need to revoke access for an existing user or if you need
to change a user from an Admin user to a Basic user, please contact
Support.

What happens next?

The new user will receive an email verifying their details along with instructions to complete
setting up their account.
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